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Les fours à chaux de la Panouse sont situés dans le 9ème arrondissement de Marseille et au 
commencement du parc des Calanques. Suivant une longue tradition de production de chaux
depuis l’antiquité sur ce territoire, ils intriguent cependant par le soin qui a été porté à leur 
fabrication et leur histoire mouvementée : en effet ils ont changé régulièrement de propriétaire
et leur activité de l’époque est floue.

C’était le parfait sujet de recherche pour illustrer les interrogations qui se posent dans ce 
séminaire : « Patrimoine et Humanité Numérique » : Comment des outils tels que la 
photogrammétrie peuvent-ils aider à comprendre la place qu’ont occupé les fours de la
Panouse durant leur fonctionnement ?

1

Illustration 1: Plan de situation, Vallon de la Panouse  source : Géoportail



 Ce travail s’est tout d’abord centré sur la carrière, puis sur les fours et le grappier, les trois 
éléments principaux de la chaîne opératoire.
Il consistait à compléter les recherches historiques déjà effectuées, avec un calcul plus 
quantitatif des volumes pour pouvoir les mettre en relations avec des données des anciens 
manuels de chaufourniers.

Par un travail d’analyse de volumes croisé avec les recherches historiques déjà menées, le 
but était de mieux comprendre et définir le fonctionnement de ces fours a leur époque.
De ces recherches est ressorti le volume de chaux qui a pu être produite sur le site au total, 
ou encore le temps de fonctionnement des fours.

Nous suivrons un développement en trois partie : la première concernant plutôt l’état de l’art 
et proposant une approche historique permettant de contextualiser le propos.
La seconde se portera sur la méthodologie des différentes acquisitions photogrammétriques 
et de calculs de volumes. Enfin la troisième mettra en avant les liens et conclusions que 
permettent le croisement des données historiques et des volumes obtenus.
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I. Approche Historique

Dans cette première partie nous ferons un point sur l’état des connaissances sur les 
différentes étapes de la chaîne opératoire de production de la chaux : la carrière, les fours et 
le grappier.
Cette partie permet de contextualiser les fours a chaux de la Panouse dans l’agglomération 
Marseillaise pour mieux interpréter les résultats de l’analyse photogrammétrique proposée 
plus tard.
Les sources proviennent des rapports des années précédentes d’Anne Marie d’Ovidio, des 
manuels de chaufourniers et d’autres ressources en ligne.

I.1 Carrière

I.1.1 Nature de la roche
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Illustration 2: Carte géologique de l'agglomération Marseillaise  source : Géoportail



Une étude du CICRP menée par Philippe Bromblet et Vincent Mercurio a procédé à l’analyse 
de roche prélevée dans la carrière. La conclusion est que le matériau est « un calcaire fin 
marneux impur, qui contient une fraction détritique non négligeable composée de fins grains 
de quartz, des minéraux argileux diverses (kaolinites, illites et argiles à 14 Å) et aussi de la 
matière organique. »

C’est avec ce marnocalcaire qu’on va pouvoir produire de la chaux hydraulique, très 
appréciée à l’époque du fonctionnement des fours, comme nous le verrons dans la partie des
fours. Cette poche de marnocalcaire est relativement rare car elle ne se situe qu’au niveau de
la carrière de la Panouse et de celles de Vaufrèges. C’est la seule poche de marnocalcaire de
Marseille et des calanques, et donc un endroit qui parait stratégique.

« La cuisson à haute température (>1000°C) d’un tel matériau doit produire […] une chaux 
hydraulique naturelle plutôt qu’une chaux aérienne purement calcitique. »
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Illustration 3: carte géologique du vallon de la Panouse  source : Géoportail
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Illustration 4: coupe paysagère centrée sur le Vallon de la Panouse

Illustration 5: Plan de situation des éléments de la chaîne opératoire à la Panouse
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Illustration 6: Vallon de la Panouse  source : photo personnelle

Illustration 7: Vallon de Vaufrèges  source : photo personnelle



I.1.2 Chaîne opératoire

La chaîne opératoire de la production de la chaux est relativement assez simple, malgré un 
grand savoir faire à avoir dans l’exécution, notamment pour mener un feu efficace et retirer 
un maximum de produit final a partir de la matière première.

« abattre les pierres, les réduire en fragments grossièrement calibrés, les transporter aux 
fours, concasser les produits qui en sortent, procéder à « l’extinction » en aspergeant d’eau, 
broyer et bluter, sécher, mettre en sacs, tout cela est relativement aisé. Sauf la cuisson dans 
les fours, ces différentes opérations peuvent être faites sans machines par des hommes 
armés d’instruments primitifs. »
L’industrie de la chaux dans le sud-est de la France

La carrière est le premier élément de la chaîne opératoire, d’où l’on va extraire la matière 
première : le calcaire qui va servir à produire la chaux.
Il semble que le calcaire était préférablement cuit directement ou peu de temps après son 
extraction pour que l’humidité permettent une meilleure cuisson. Ainsi, le caractère aride du 
vallon de la Panouse et des calanques en général ne permettait peut-être pas une efficacité 
optimale.

« L'expérience a appris aux chaufourniers que l'humidité favorisait l'opération de la cuisson. 
Aussi préfèrent-ils la pierre nouvellement extraite de la carrière, ou arrosent- ils celle qui a été
exposée très-longtemps à l'air sec. C'est la même raison qui fait qu'ils aiment mieux le bois 
qui n'est pas tout à fait sec, ou qu'ils mouillent fortement la houille au moment de s'en servir, 
et que l'opération marche plus rapidement par un temps humide que par un temps sec. »
Nouveau manuel complet du chaufournier, Magnier, p.41
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I.1.3 Question du transport

- carrière proche des fours

Le facteur limitant les bénéfices va essentiellement être le transport de la matière première : 
en effet la matière première employée est très peu chère, beaucoup moins que le 
combustible employé bien qu’il soit de faible qualité. Un transport trop important viendrait 
gonfler son prix en de trop fortes proportions vu le tonnage énorme nécessaire pour faire du 
bénéfice.

« Il est nécessaire que les pierres extraites, produits de faible valeur marchande, ne soient 
pas grevée» de frais de transport jusqu'à l'usine où on va 1er transformer en chaux et en 
ciments; sinon, l'exploitation serait ruineuse »
L’industrie de la chaux dans le sud-est de la France

« La matière première de cette industrie n’a en elle même qu’une très faible valeur 
marchande. […] Il faut ainsi éviter à tout prix de la transporter. La répartition des usines se 
trouve donc commandée impérieusement par la nécessité d’être proches de leurs carrières. »
L’industrie de la chaux dans le sud-est de la France

Il est rapporté que le prix des sacs de transports était plus élevé que la valeur de la chaux elle
même !
« Il n'est que de noter que le prix des sacs employés aux transports est parfois plus élevé 
que celui de la marchandise : pour une tonne de chaux à 85 ou 100 francs, il faut utiliser 
environ 22 sacs à 5 francs pièce, soit 110 francs ! Un produit aussi bon marché ressentira 
évidemment avec violence les moindres frais de transport. »
L’industrie de la chaux dans le sud-est de la France

- fonctionnement en pente

Le cas de la Panouse représente typiquement un fonctionnement en pente, ou « en 
cascade ». C’est le plus répandu car c’est celui qui demande le moins d’efforts pour le 
fonctionnement de toute la chaîne opératoire. Avec la mise en place des fours en contrebas 
de la carrière, peu d’efforts sont mis en place pour le transport de la matière première.

« Usines en cascade : la carrière en haut, les fours à mi-côte, les broyeurs et l’ensachage en 
bas, de façon que toutes les opérations se fassent par gravité »
L’industrie de la chaux dans le sud-est de la France
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I.1.4 Outils et main d’oeuvre

Les outils permettant l’extraction sont simples car le calcaire se présente en lits de pierre, 
formant des bancs facilement détachables
Ces lits étaient extraits par percussion et/ou explosion. Les outils pour la percussions étaient 
la pioche ou la barre à mine. 
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Illustration 8: Outils pour extraire les lits de 
calcaire  source : Art du Chaufournier, Biston



On retrouve des traces d’impact et de rouille dans la carrière correspondant peut être à des 
impacts de pioche ou de barre à mine.

On a également retrouvé des traces de percements dans la carrière pour y insérer de la 
poudre noire et travailler à l’explosif.
Cinq trous de perforation pour insérer la poudre noire ont étés retrouvés. Ils présentent des 
longueurs variables de 0,7 à 1m mais un diamètre commun de 5cm. (source : rapport d’Anne 
Marie d’Ovidio)
Cependant on ne sait pas a quelle fréquence ni quelle ampleur avait cette pratique.
Les manuels de chaufournier ( antérieurs au XXe siècle ) ne mentionnent pas ces pratiques.
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Illustration 9: Traces d'impact et de rouille dans la 
carrière  source : photo personnelle

Illustration 10: trou pour l'insertion des explosifs  
source : Rapport d'Anne-Marie d'Ovidio



Le calcaire était concassé grossièrement a la taille d’un poing pour augmenter la surface 
d’échange lors de la cuisson. Cette atelier n’a pas été retrouvé mais se trouvait probablement
au pied de la carrière, enseveli dans les gravats.
Il était ensuite transporté jusqu’aux gueulard des fours

« il faut des hommes forts pour arracher la pierre du flanc de la carrière, pour la briser, la 
transporter, pour casser les clinkers a la sortie des fours, broyer en poudre, porter les sacs »
L’industrie de la chaux dans le sud-est de la France

L’industrie de la chaux emploi peu d’ouvrier du bas prix du produit fabriqué et de la simplicité 
relative des opérations. La plupart du temps des ouvriers étrangers étaient employés pour 
ces taches difficiles, notamment des Italiens du a la proximité géographique. On emploie 
aussi des paysans de la région. Dans tous les cas la plupart des ouvriers ont une activité 
paysanne, et les fours tournent à plein régime essentiellement l’hiver. On a du mal a trouver 
assez d’ouvriers.

On n’est pas encore a la période d’automatisation du travail qui aura lieu au XXe siècle.
Le main d’œuvre faisant fortement augmenter le coût du produit final, les exploitants 
s’efforceront de réduire le nombre d’ouvriers et d’automatiser au maximum différentes étapes 
de la production : broyage, concassage, ensachage…
On se trouve ici encore à une période charnière.
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I.2 Fours

I.2.1 Contexte & Historique

Pendant longtemps dans ces vallons les fours à chaux sont l’activité principale
L’exploitation des fours à chaux est attestée depuis l’Antiquité dans le vallon voisin de 
Vaufrèges.
Les plus anciens étaient des fosses circulaires creusées à même le sol. L’activité de 
chaufournier était alors nomades : on récupérait des fagots, bruyères et petit bois aux 
alentours. Lorsque les ressources de combustible étaient épuisées on allait brûler la chaux 
dans une autre zone le temps que la garrigue repousse.
On a retrouvé plus de 250 fours à chaux temporaires de ce type dans les calanques, 
notamment après les incendies des dernières années.

Aujourd’hui on continue de produire la chaux dans des fours à mélange plus sophistiqués, 
utilisant du gaz-oil ou du gaz, ou encore rotatifs.

On considérait les chaufourniers comme des bandits de grand chemin, on note l’installation 
de Templiers a Vaufrèges pour sécuriser le chemin Cassis-Marseille.
L’activité est maintenue à l’écart des villes à la fois de part sa ressources naturelle que l’on 
trouve dans certaines zones escarpées peu propices à la construction, mais aussi pour se 
préserver des fumées rejetées dont on connaît la toxicité, en témoigne les arrêtés 
Napoléoniens qui contraignent les industries polluantes à s’établir hors de la ville.
Ces restrictions impactent peu la production de chaux qui est par nature en dehors de la ville,
proche de la matière première, contrairement à d’autres industries qui on souffert de ces 
nouvelles lois.
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Ce site de la Panouse à une histoire mouvementée : Ces fours étaient assez importants pour 
l’époque mais on très peu étés utilisés.

résumé : 

- 1857 : Les sieurs Antoine Homsy et Felix Gravier, des hommes d’affaires, construisent le 
double four à chaux de la Panouse.
- 1870 : Ces fours sont vendu à Pierre Hilaire Curtil, architecte et gros entrepreneur reconnu 
à Marseille.
- 1877 : Vendu à Alexandre Fontaine dont l’activité n’est pas connue
- 1881 : Vend la moitié du terrain.

Les sieurs Antoine Homsy et Felix Gravier n’auraient exploité le four que durant 13ans. On 
peut remarquer que les fours n’ont jamais étés detenus par des chaufourniers de métier, et 
les ventes successives laissent penser que la production du four n’intéressait pas vraiment 
les propriétaires.
On mentionne plus tard la four comme un « four a poulet » ( couvoir ) et des transformations 
permettent d’attester que le four n’était plus fonctionnel.

L’histoire de ces fours prend donc sa place lors de la révolution industrielle du XIXe siècle qui 
va faire basculer la France et toute l’Europe d’une économie artisanale à une économie 
industrialisée en passant des ateliers aux usines.
Ainsi ces fours représentent le témoignage d’une époque charnière.
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I.2.2 Nature des fours

On retrouve deux classifications bien distincte des fours a chaux : 

- les fours a longues ou à courtes flammes
- les fours à calcination périodique ou continue

Les fours de la Panouse étaient des fours continus à courte flamme : 

- à courte flamme ou « à petit feu » car ils fonctionnaient par des alternances de lits de 
combustible ( plus généralement de la houille, des lignites, de la coke ) et des lits de calcaire.
Cette technique est l’évolution des fours à longues flammes qui séparaient carburant et 
calcaire, le plus souvent un foyer alimenté avec du bois sous le calcaire maintenu par une 
voûte en pierre.

« la calcination de la pierre s’opère au moyen d’un petit feu par couches répétées, et 
alternativement entremêlées avec les pierres »
Art du chaufournier, p.30

- à calcination continue ou « fours coulants » car on récupère la chaux au fur et a mesure 
qu’on recharge du calcaire, en continu. La chaux vive va couler dans la gueule du four, aussi 
appelée cendrier, ou on va la récupérer. Elle peut être récupérée par le moyen de grilles fixe 
qu’on va gratter ou taper, ou des grilles mobiles qu’on va ouvrir.
Avec ce type de fonctionnement, les différentes étapes en amont et en aval de la chaîne de 
production peuvent se faire en même temps que la cuisson.
Avec ce type de fours industriel, on arrivait à une économie sur la pierre à calciner et sur le 
temps nécessaire à la calcination en comparaison aux autres types de fours déjà existants.

Une annexe couverte utilisée pour éteindre la chaux, la trier, l’ensacher était attenante aux 
fours. Cela permettait une moindre déperdition de chaleur.

« L'un des moyens les plus efficaces pour prévenir le refroidissement qu'occasionne toujours 
l'air environnant sur la surface extérieure des fours, c'est de les enterrer profondément 
comme quelques-uns de ceux dont nous avons-parlé, ou d'y accoler d'autres constructions, 
telles que des magasins propres et utiles à l'exploitation. »
Manuel théorique et pratique du chaufournier, Biston
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« Ces fours ont généralement la forme d’un ellipsoïde de révolution, tronqué par ses 
extrémités »
Nouveau Manuel complet du chaufournier, Magnier, p.109

fonctionnement d’une fournée :

Le chaufournier descend dans le four et dispose alternativement une couche de calcaire : une
charge, et une couche de combustible : une charbonnée.
Plusieurs journaliers lui font parvenir des mannes ou paniers remplis de calcaire et de houille 
a l’aide de cordes.
Pour l’allumer on y dispose à la base trois ou quatre brassées de bois bien sec ( ou 
éventuellement de bruyère comme on en retrouve dans le vallon de la Panouse ) puis par 
dessus une grosse couche de morceaux de houille de calibre important.
On laisse le feu dormant pendant un ou deux jours pour monter en température puis on joue 
sur l’ouverture de vannes pour faire circuler l’air et augmenter le tirage.
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Illustration 11: coupe typique d'un four 
a calcination continue à courte flamme 
source : Nouveau Manuel complet du 
Chauffournier, M. M.-D Magnier



I.2.3 Nature de la chaux

On a produit deux types de chaux à la Panouse d’après les analyses géologiques et du 
grappier.

- la chaux hydraulique

La chaux hydraulique, ou chaux légère, représente de 15 à 18 % d'argile. 
Le phénomène de cristallisation s’opère en milieu aqueux. Elle est très employée comme liant
hydraulique, en particulier pour tous les bétons en élévation. Elle est plus solide et peut 
s’employer à l’humidité.
C’est celle qui était produite à partir de la carrière attenante, elle est d’une qualité supérieure 
à la chaux grasse ou aérienne et est très recherchée pour sa résistance et sa tenue 
notamment pour les ouvrages sous-marins.

« Il ne faut pas que la dénomination de chaux hydraulique fasse croire que cette chaux ne 
donne de bons résultats que lorsqu'elle est employée dans l'eau; sa supériorité sur les chaux 
ordinaires est également incontestable pour toutes les constructions en général, soit à l'air, 
soit sous terre; et l'on peut admettre comme un fait d'expérience bien établi, que la résistance
des bons mortiers hydrauliques employés dans ces circonstances est égale à celle de classe 
moyenne des pierres à bâtir »

- la chaux aérienne

Elle contient moins de 5 % d’argile. On l’appelle soit chaux grasse lorsqu’elle est très pure 
( de 0,1 à 1% d’argile ) ou chaux maigre ( de 1 à 5% d’argile ).
Le phénomène de cristallisation s’opère à l’air libre.
Utilisée comme mortier souple ou enduit, elle est moins résistante.
On sait d’après des analyses du grappier qu’il a été produit de la chaux aérienne a la 
Panouse
On suppose que le calcaire a été prélevé sur le versant en face de la carrière, ou importé.
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I.2.4 Nature du combustible

Dans le cas de la Panouse, des analyses des scories ont montré que le combustible était au 
moins en partie récupéré des hauts fourneaux de Marseille, et devait donc avoir des qualités 
moindres. 

Raoul Blanchard rapporte dans L’industrie des chaux et ciments dans le sud est de la france, 
p.287 que la région des Bouches du Rhone était celle  « où l'emploi des combustibles les 
plus variés et les plus hétéroclites est en faveur » et évoque le cas des fours voisins à la 
Panouse qui utilisaient eux aussi ces «  résidus de la plus basse qualité, véritable ersatz de 
charbon » :
« En triant les scories extraites de chaudières consommant du bon charbon, par exemple 
dans les usines de produits chimiques, les verreries, les établissements métallurgiques, ou 
les déchets rejetés dans les dépôts par les locomotives, on obtient un combustible tout à fait 
inférieur, mais susceptible encore de brûler dans les fours à chaux, à condition que son poids
soit presque égal à celui des pierres à cuire. Ces résidus, dont le prix est infime, 
s'accommoderaient mal d'un transport prolongé qui en rendrait l'emploi trop coûteux ; ce n'est
donc qu'aux abords mêmes de l'agglomération marseillaise, à Vaufrèges, le Fangas, la 
Bouilladisse, Septèmes, qu'on les utilise, concurremment avec les lignites locaux, et cette 
utilisation paraît plutôt en décroissance. »

L’emploi de ce genre de combustible semblait donc nettement abaisser le rendement :
M. Fourcroy de Ramecourt écrit à ce sujet : « il faut, en employant cette houille, faire les 
charges de pierre plus minces, la menue pierraille y convient mieux » Art du chaufournier, 
p.34

Cependant les fours de la Panouse devaient mettre en place le même système 
d’approvisionnement que leurs voisins de Vaufrèges : 
« Les usines dans la banlieue marseillaise, s'alimentent par camion à Marseille même; 
comme les véhicules doivent descendre en ville les produits fabriqués, le charbon (lignites et 
résidus) constitue un véritable fret de retour et se trouve ainsi transporté sans dépenses 
supplémentaires. »
L’industrie des chaux et ciments dans le sud est de la france, Raoul Blanchard, p.287
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I.3 Grappier

I.3.1 Nature des déchets

Les parties inutilisables et impropres à la vente vont être stockées en tant que déchet, le long 
de la route  menant vers les fours dans notre cas à la Panouse.
C’est un « talus blanchâtre qui s’est formé par l’accumulation des résidus de cuisson, des 
incuits, surcuits. Il continent des scories, pierres de calcaire grisâtre, fragments de briques, 
gros fragments de scories »
Il correspond à la protubérance en contrebas de la production ou on a stocké les parties non 
calcinées des cuissons, impropres a la vente.
Les déchets vont être composés de pierres mal calcinées non réutilisables, les noyaux ainsi 
que des bouts de roche impurs. Le bas et le sommet du four sont fortement sujets à la 
production de pierre mal calcinées dues aux variations de température de cuisson et aux 
intempéries qui donnent une calcination inégale.

“Lorsque les vents chassent violemment et longtemps d’un même côté, ainsi que la pluie, les 
pierres du sommet qui sont le plus près du vent, ne se calcinent pas, et restent en 
écrevisses, malgré les abri-vents.” art du chaufournier, p.18

I.3.2 Possibilités de réemploi

- grappier utilisé pour faire du ciment de grappier,

on retrouve des traces de piquetage qui montre des prélèvements ponctuels
« Le ciment de grappier à été inventé par Lafarge en 1868 et a disparu à la première guerre 
mondiale. »
Le mur de la maison du chaufournier a côté du grappier seraient peut être montés avec ce 
ciment de grappier.

- grappier trié et réutilisé dans une deuxième cuisson

Une partie de ces déchets va être triées et recuite ultérieurement.
On retrouve des “Noyaux” dans ces pierres, aussi appelés “Rigaus et Marrons”.
“Les chaufourniers ont encore soin de trier au sortir du four les morceaux qui contiennent de 
la pierre non calcinées, l’habitude la leur fait connaître a l’œil. Ils rejettent aussi les roches, 
qu’ils appellent chaux brûlée.” art du chaufournier, p.40
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II. cas d’étude appliqué, utilisation des volumes 

II.1 Carrière 

II.1.1.Acquisition

Les problématiques de cette acquisition étaient : 
D’abord le fait que l’objet à reconstituer était grand et peu accessible à cause des 

fortes pentes et de la garrigue qui empêchait de se déplacer librement.
Puis la présence de recoins et de plis qui complexifiait le parcours a mettre en place 

pour modéliser l’entièreté du modèle.

J’ai donc choisi de faire deux acquisitions : une en me positionnant en hauteur sur le 
versant face à la carrière (1) pour avoir une vision globale et la plus complète possible. Une 
autre depuis l’intérieur de la carrière (2), plus précise mais concernant seulement une partie 
de la carrière. Ces deux acquisitions ont ensuite été fusionnées.

L’acquisition à été réalisée par un temps nuageux pour avoir une lumière uniforme, avec un 
Canon EOS70D
La première partie comportait 28 photos et la seconde 24 photos
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Voici le parcours fait pour l’acquisition des deux parties :
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II.1.2 Modélisation et discrétisation

Le traitement des photos a été fait sur le logiciel Agisoft Photoscan 1.2.5 en suivant le 
développement logique du logiciel : 
- alignement des photos ( tri selon la qualité )
- génération d’un nuage dense

Une fois ce procédé fait deux fois, une pour chaque partie, les deux nuages denses obtenus 
ont été importés au format .PLY et fusionnés sur CloudCompare avec la fonction « aligner 
deux nuages »  ( align two clouds by picking (at least 4) equivalent point pairs ) en retrouvant 
des points caractéristiques communs dans les deux nuages de points.
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Le nuage de points dense qui en résulte a ensuite été mit à l’échelle. J’ai mesuré une 
distance sur place entre deux points caractéristiques de la carrière pour ensuite la retrouver 
dans le modèle.

Les normales ont également due être générées car la fusion des deux nuages denses les 
avait altéré
Edit > Normals > Compute
Elles sont inversées car le logiciel détecte que la surface arrondie du dessous de la carrière 
est la surface principale
Edit > Normals > Invert

Puis, le maillage a été généré avec le Plugin Poisson installé dans CloudCompare
Plugins > PoissonRecon

Pour finir, on passe sur MeshLab pour réduire le nombre de polygones du maillage. Le but 
est de garder le maximum d’information pour être le plus précis tout en ayant un fichier qui 
puisse être ouvert et manipulable dans sketchup.
On passe de 52 027 à 25 000 faces
File > Import Mesh
Filter > Remeshing, Simplification and Reconstruction > Simplification : Quadric Edge 
Collapse Decimation
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discrétisation :

Cette réduction du nombre de faces est au départ purement matérielle : elle se fait dans 
l’optique d’avoir un fichier exploitable sous Sketchup.
Elle est acceptable car la marge d’erreur est de toutes façons importante du fait de plusieurs 
facteurs :
- la présence de végétation ( buissons bas ) dans le modèle qui interfère et se fond dans la 
modélisation
- la présence possible de lits de terre entre des bancs de calcaire dans la carrière
- la reconstitution de la surface initiale de la carrière qui est une supposition comme nous 
allons le voir plus bas
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II.1.3 Délimitation et fermeture du volume

Une fois ce maillage de la carrière obtenu il fallait se poser des questions méthodologiques 
sur la manière de refermer le volume de la carrière pour en extraire le volume.
Ainsi, il a fallu définir les limites de la carrière et la surface du volume qui vient reconstituer la 
surface de calcaire à l’origine, avant exploitation.

Les limites ont été définies en plan et sur le terrain, en fonction de la différence de texture 
entre la pierre à nu et la garrigue, et les décrochés de roche qui montrent une exploitation.
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Illustration 12: carte de délimitation de la carrière 



L’hypothèse principale a été de dire que la surface de la carrière avant exploitation suivait la 
pente naturelle du vallon.
Ainsi, des coupes ont été réalisées tous les 5m dans la modélisation 3d avec le contexte 
élargi et la pente du vallon pour reconstituer un objet qui représenterait de la manière la plus 
fidèle possible le volume de calcaire exploité dans cette carrière.
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I.1.4 calcul du volume

Après avoir prit en compte ces différents facteur, le maillage est importé au format .STL sur 
Sketchup. L’objet est isolé de son terrain naturel et refermé selon la coupe définie 
précédemment pour reconstituer la surface initiale.
On crée un composant
Clic droit > Make component

Lorsque le volume est bien fermé, Sketchup indique le volume du composant dans le menu
Informations sur l’entité

Ici on obtient un volume d’environ 5730 mètres cubes.
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Illustration 13: modèle 3d importé sous sketchup
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Illustration 14: height map de la carrière



II.1 Fours

30

Illustration 15: Documents issus du rapport d’Anne Marie d’Ovidio, a
partir de l’orthophoto de B.Sillano, INRAP



Le calcul du volume des fours à été beaucoup plus simple et a nécessité moins de 
manipulations logicielles.
La photogrammétrie n’a pas été utilisée ici.

J’ai pu m’appuyer sur la base de documents déjà produits, et notamment une coupe d’un des 
deux fours réalisé par des étudiants des années précédentes et présents dans un rapport 
annuel d’ Anne Marie d’Ovidio.
Je reprend l’hypothèse formulée par les étudiants ayant travaillé sur des hypothèses de 
reconstitution des fours, qui plaçaient la grille permettant de récupérer la chaux vive tombant 
des fours à environ 2m de la base du four, au niveau des ouverture rajoutées ultérieurement.

31

Illustration 16: travaux étudiants précédents portant sur des hypothèses de reconstitution des fours



On part du principe que les deux fours sont symétriques et réguliers.
J’ai retracé le profil du four a partir de la coupe puis j’ai utilisé l’outil Suivez-Moi pour former 
un volume.

Après avoir créé un composant, Sketchup indique un volume de 49 mètres cubes.

Avec les deux fours on a donc un volume total de 98 mètres cubes.
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II. 3 Grappier

La méthodologie pour estimer le volume du grappier a été similaire à celle mise en œuvre 
pour la carrière.
Ici, le modèle 3d a été formé à partir d’un seule acquisition de 68 photos avec le Canon 
EOS70D, la aussi faite en arc sur l’autre versant du vallon (3) afin de prendre de la hauteur 
pour avoir une vision globale.
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Les limites ont été définies par les différences de texture et les différences de volumes 
semblant peu naturelles.

La démarche pour reconstituer le terrain d’origine avant le déversement de ces déchets de 
cuisson à été la même que pour la carrière mais avec une logique inversée : on a d’un coté 
un volume creusé dans la roche, de l’autre un volume rajouté.
Des coupes ont été produites tous les 10m afin de reconstituer le terrain initial en fonction de 
la pente amont et aval.
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Illustration 17: carte de délimitation du grappier
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Une fois l’alignement des photos et le nuage dense générés sur Photoscan, on génère le 
mesh et on met à l’échelle sur CloudCompare, réduit le nombre de polygones sur Meshlab et 
on referme le volume sur Sketchup.

On obtient un volume d’environ 395 mètres cubes.
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III. Résultats et questionnements ?

Combien de chaux a pu être produite au total ?
Combien de chaux pouvait être produite par fournée ?
Le volume du grappier concorde-t-il avec le volume de la carrière ?
Ces données concordent elles avec la durée d’utilisation des fours ?

Ces données purement quantitatives réalisées par le moyen de la photogrammétrie sont 
intéressantes et révélatrices lorsqu’on les met en relation avec les informations que l’on peut 
retrouver dans les rapports des années précédentes et les différents manuels de 
chaufourniers existants pour comprendre comment fonctionnait ce site de la Panouse.

Pour cela, principalement quatre ouvrages de chaufourniers ont étés utilisés pour leur 
informations sur les rendements d’un four, les temps de cuisson, le nombre d’ouvriers, etc. :

- Art du Chaufournier, Fourcroy de Ramecourt
- L’industrie des Chaux et Ciments dans le Sud-Est de la France, Raoul Blanchard
- Manuel Théorique et Pratique du Chaufournier, Valentin Biston
- Nouveau Manuel Complet du Chaufournier, M M.-D Magnier

CARRIÈRE 

A partir du volume de calcaire extrait de la carrière, on cherche a déterminer le volume de 
chaux que cela a pu donner. 
On fait l’hypothèse que le calcaire était affleurant, et qu’il suivait la courbe naturelle de la 
pente.
Ainsi, le volume estimé est composé uniquement de marnocalcaire.

“Lorsqu”un tel four est bien allumé, que la houille est égale ou homogène et de bonne qualité,
il peut par un temps favorable produire chaque jour en chaux de pierre jusqu’à la moitié de la 
pierre dont il est chargé: quelquefois son produit ne va qu’au tiers, et si la houille est de peu 
de force, il rend encore moins.” Art du chaufournier p.40

En prenant en compte le fait que les fours de la Panouse utilisaient en partie un 
combustible recyclé des hauts fourneaux, et donc de peu de force et que le vent 
soufflant régulièrement dans les calanques devait limiter la production, on peut 
émettre l’hypothèse que le rendement était d’environ 1/3.

Avec un volume total de la carrière d’environ 5730m cubes, on a un volume total de 
chaux hydraulique produit à la Panouse d’environ 1910m cubes.
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GRAPPIER

Une des hypothèses est que les déchets étaient triés à la sortie du fours puis lorsqu’ils 
s’accumulaient en trop grande quantité ils étaient déplacés par charriot le long du chemin 
pour les stocker.

L’idée est de mettre en relation le volume de matière première récupérée en amont dans la 
carrière et le volume de déchets de cuisson déposés plus bas le long de la route.

Avec la modélisation du talus de déchets de cuisson le long de la route, on a 395m 
cubes de déchets.
En comparaison au volume total de la carrière on a 5730:395  = 14,5 ce qui correspond 
quasiment au ratio allant d’un quinzième évoqué par M. Fourcroy de Ramecourt dans 
son ouvrage Art du chaufournier.

« On doit compter sur une diminution de la pierre que j’estime d’un quinzième sur toutes les 
espèces de pierres dures que j’ai vu calciner. » p.40

5730:15 = 382m cubes de déchets correspondant à la carrière de marnocalcaire.
         soit 395 – 382 = 13m cubes de déchets correspondant à une source inconnue.
Ainsi avec une réduction d’1/15 lors de la cuisson, le volume du grappier semble indiquer 
qu’environ 13mcubes correspondent à des cuissons extérieures à la carrière.

On sait que de la chaux aérienne a aussi été produite à la Panouse en petite quantité.
C’est ce volume de grappier qui ne correspond pas au calcaire extrait de la carrière mais 
venant de l’extérieur, sur le versant en face ou d’un autre vallon.

13x15 = 195
On peut donc supposer qu’on a cuit à la Panouse environ 195mcubes de calcaire pur 
de chaux aérienne, de l’autre coté du vallon.
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FOURS

Les fours de la Panouse sont des fours a courte flamme avec cuisson continue, on a une 
alternance de calcaire et de combustible.
Le combustible semble être un réemploi des haut fourneaux de Marseille (source rapport 
Anne Marie d’Ovidio)

Pour calculer le volume de calcaire pur utilisé dans un fournée, il nous faut estimer la quantité
de calcaire et la quantité de combustible nécessaire.

“Pour charger un four de cette manière, on emploie 
communément huit à dix manœuvres, et, dans ce cas, il 
faut une heure environ pour masser 2m.50 cubes. 
 “ Manuel chaufournier, Magnier, p.115

Dans notre cas pour remplir complètement nos deux fours de 49m cubes chacun qu’on 
chargeait aux 3/4 il faut donc un jour et demi de travail complet ( 37heures )  pour les charger 
et lancer une cuisson.

espace entre les blocs de calcaire après concassage :
“les chaufourniers sont beaucoup mieux fondés sans doute à croire que six toises cubes ( 1 
toise = 6 pieds = 1,949m ) de pierres mesurées comme elles sont rangées aux carrières, n’en
font plus que cinq toises lorsqu’elles sont dans le four.” art du chaufournier, p.18

« Un four de 600 pieds cubes ( 17m cubes ) peut donc fournir communément 1620 pieds 
cubes ( 46m cubes ) de chaux par semaine de six jours de travail » Art du chaufournier p.40

« j’ai reconnu que certaines pierres exigeoit jusqu’au tiers d’une même houille » Art du 
chaufournier, p.41

Ainsi, dans deux fours de 49mcubes, soit 98mcubes, qu’on remplissait aux 3/4 on 
pouvait entreposer 1/3 de houille et 2/3 de calcaire en morceaux de la taille d’un poing.
Dans ces 2/3, 4/5 de calcaire pur et 1/5 d’air entre les morceaux.
On a donc 39m cubes de calcaire pur qui nous donnera 13mcubes de chaux par jour.

On utilise donc 234mcubes de calcaire par semaine de 6jours de travail.

L’équivalent de 24semaines de 6jours de travail pour consommer le volume total de la 
carrière.

Cela parait peu, sachant que les fours sont supposés avoir été exploités au moins sur 
une période de 13ans.
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Avec ces résultats on peut émettre plusieurs suppositions : 

-  Les fours n’étaient utilisés que de manière sporadique, on sait que des périodes de 
plusieurs années ont eu lieu sans production de chaux sur le site, notamment lors de 
changement de propriétaires.

-  Le grappier à été évacué ou réutilisé ( par exemple pour faire du ciment de grappier)  
ce qui impliquerait alors qu’une quantité importante de matière première à été utilisée 
ailleurs que dans cette carrière pour produire de la chaux aérienne ou hydraulique 
dans ces fours.

Par exemple on aurait pu importer du calcaire des carrière avoisinante : les deux autres à la 
Panouse, celle de Perasso ouverte des 1840, celles de Vaufrèges ...

- Les fours avaient un problème de rendement, qui peut s’expliquer par la mauvaise 
qualité du combustible utilisé ou encore peut être par un problème de conception des 
fours.
Ainsi on chargeait plus de combustible dans les fours.

Consommation à Marseille :
c’est autour de Marseille que la consommation s’élève le plus, en raison de la nature 
défectueuse du combustible. Chez Carvin fils, à Vaufrège, la fabrication de la chaux 
hydraulique réclame 850kilogs de  lignite et de résidus de chaudières des usines de 
Marseille. Et au Fangas, 830kilogs des mêmes lignites, dits croûte de Trets, par tonne de 
chaux grasse. » L’industrie de la chaux dans le sud-est de la France, p.277

On a sur ce site une production artisanales dans sa quantité avec des fours et une 
installation industrielle.                                                                                                             

Pourquoi ces fours n’ont pas beaucoup étés exploités :

On peut penser à un problème géographique. De l’autre côté les fours de Vaufrèges étaient 
beaucoup plus développés mais ils bénéficiaient d’un emplacement stratégique entre 
Marseille et Cassis qui permettait des importations et exportations beaucoup plus rapides.
Au Vallon de la Panouse on est dans un cul de sac beaucoup moins accessible.

Aussi, les propriétaires successifs de ces fours n’étaient pas des chaufourniers mais des 
hommes d’affaire. Il est probable qu’ils aient fait l’acquisition des fours pour placer de l’argent,
posséder plus de terre sans l’intention de l’exploiter en continu.
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Dans les rapports des années précédentes des doutes étaient déjà émis quand a la 
production de ces fours et leur période de fonctionnement.
Ces données quantitatives viennent enrichir ces questionnements : 

En effet, les fours étaient en capacité d’exploiter le volume total de la carrière en seulement 
24semaines de travail de 6 jours.
Le volume du grappier confirme qu’on a produit en petite quantité venant d’une source 
extérieure à la carrière, ce qui étaye les analyses étayant qu’on avait produit de la chaux 
aérienne à la Panouse.
Cependant, cette production annexe est limitée en quantités, ce qui amène la durée 
d’exploitation aux maximum à 25 semaines au total.

On peut conclure que les fours de la Panouse étaient un investissement ambitieux dans une 
période charnière de révolution industrielle qui misait sur une production rationalisée et 
importante.
Mais des événements inconnus, des problèmes de rendements ou d’autres plus personnels 
des propriétaires, n’ont pas permit l’exploitation du potentiel de ces fours.

42



Bibliographie :

- Rapports archéologiques Anne Marie D’OVIDIO sur les fours de la Panouse 2015, 2016, 
2017

- BISTON Valentin, Manuel Théorique et Pratique du Chaufournier, 1836

- BLANCHARD Raoul, L’Industrie des Chaux et ciments dans le Sud-Est de la France, 1928

- FOURCROY DE RAMECOURT, Art du Chaufournier, 1761

- MAGNIER M. M. -D, Nouveau Manuel complet du Chaufournier, 1881

- carte des carrières de la Brgm
http://pierresud.brgm.fr/

- cartes géologique Géoportail
https://www.geoportail.gouv.fr/

43


